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Tente uma, duas, três vezes e se possível tente a quarta, a quinta e quantas vezes

for necessário. Só não desista nas primeiras tentativas, a persistência é amiga da

conquista. Se você quer chegar a onde a maioria não chega, faça o que a maioria

não faz.

(Bill Gates)

As almas de todos os homens são imortais, mas as almas dos homens justos são

imortais e divinas.

(Sócrates)

Se o dinheiro for a sua esperança de independência, você jamais a terá. A única

segurança verdadeira consiste numa reserva de sabedoria, de experiência e de

competência.

(Henry Ford)

A grande �nalidade da vida não é o conhecimento, mas a ação.

(Thomas Huxley)

Há homens que lutam um dia e são bons, há outros que lutam um ano e são

melhores, há os que lutam muitos anos e são muito bons. Mas há os que lutam

toda a vida e estes são os inigualáveis.

(Bertolt Brecht)

Se A é o sucesso, então A é igual a X mais Y mais Z. O trabalho é X; Y é o

lazer; e Z é manter a boca fechada.

(Albert Einstein)

Se vi mais longe foi porque estive sobre o ombro de gigantes.

(Isaac Newton)

A maior recompensa para o trabalho do homem não é o que ele ganha com isso,

mas o que ele se torna com isso.

(John Ruskin)

Lute. A vida não será mais fácil pra você só porque é uma boa pessoa, por isso

nunca deixe de lutar pelos seus objetivos.

(Clériston Silva Gama)



RESUMO

Neste trabalho serão apresentados resultados baseados na modelagem e processamento de

dados sísmicos sintéticos e um dado real. Isso para analisar os efeitos da contribuição das

correções estáticas de campo e residual, e quando esta pode ser desprezada ou não, me-

diante comparação dos resultados, mostrando ao usuário a contribuição de sua aplicação

e as consequências que se acometerão por isso ou �preço� que pagará caso não a aplique.

Este trabalho apresentará o processamento completo de uma linha sísmica real e também a

modelagem direta de quatro dados sintéticos. A linha sísmica real escolhida para o mesmo

foi a linha 2D 26-RL-1993 localizada no Compartimento Nordeste da Bacia do Recôncavo,

disponibilizada ao LAGEP/UFBA (Laboratório de Geofísica de Exploração de Petróleo)

pela ANP (Agência Nacional de Petróleo, Gás Natural e Biocombustíveis) para �ns de de-

senvolvimento acadêmico. Tanto a modelagem direta quantos os processamentos feitos no

dado sísmico real e sintético foi utilizado o software ProMAX/SeisSpace desenvolvido pela

Landmark-Halliburton. Durante o processamento foram aplicadas etapas como: geometria,

edição, correções de tempo, análise de velocidade, empilhamento, migração além de várias

técnicas de �ltragens e correções de amplitude. Na fase da modelagem foram criados modelos

em diferentes situações para análise das correções estáticas, etapa de suma importância para

o processamento de dados sísmicos terrestres.
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ABSTRACT

This paper will present results based on the modeling and processing of Seismic data and a

real data. This is to analyze the e�ects of the Static and residual �eld corrections, and when

it can be neglected or not, Comparison of the results, showing the user the contribution of its

application And the consequences that will be faced by it or "price"Which you will pay if you

do not apply it. This work will present the complete processing of a real seismic line and also

the Modeling of four synthetic data. The actual seismic line chosen for the same Was the 2D

line 26-RL-1993 located in the Northeastern Compartment of the Recôncavo Basin, Available

to LAGEP / UFBA (Laboratory of Geophysics of Oil Exploration) By the ANP (National

Agency of Petroleum, Natural Gas and Biofuels) for development academic. Both direct

modeling and processing Data, the ProMAX / SeisSpace software developed by Landmark-

Halliburton. During processing, the following steps were applied: geometry, Editing, time

corrections, speed analysis, stacking, migration beyond several Stretching techniques and

amplitude corrections. In the modeling phase, In di�erent situations for the analysis of

static corrections, a very important step for Ground seismic data processing.
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INTRODUÇÃO

A correção estática é uma correção de tempo �xo aplicada aos traços de um agrupamento

CMP. É o processo mais corriqueiro, no que se diz respeito às distorções no tempo de trajeto

associada às camadas super�ciais, deslocamentos verticais de tempo nos traços sísmicos de

um agrupamento CMP, feitos de forma a simular a aquisição em uma elevação constante. A

determinação precisa da correção estática é um dos problemas mais importantes que devem

ser resolvidos no processamento sísmico terrestre (Cox,2001). Com o passar do tempo essa

correção foi usada mais e mais vezes e seus algoritmos foram sofrendo alterações, sendo me-

lhorados e métodos variados também criados. A correção estática é realizada resultando na

aproximação dos dados como se a aquisição fosse realizada numa superfície plana ou datum.

Para isso são necessárias informações como a velocidade do meio, logo após a zona de baixa

velocidade, altitude do ponto de tiro e receptores, além das velocidades e espessuras da ZBV

nesses pontos. A alta redundância da técnica CDP inerente à aquisição sísmica favorece

o processo de determinação das correções estáticas, ou seja, trata-se de um problema em

que normalmente dispõe-se de um número substancialmente maior de equações do que de

incógnitas e que por isso nos permite a aplicação de algoritmos so�sticados. Em muito casos

é conveniente a aplicação de um processo secundário da correção estática a correção estática

residual, que é feita após todo o �uxo normal de processamento para uma melhor precisão

dos efeitos que não foram corrigidos durante a aplicação da correções estáticas de campo.

Conforme já fora citado, existem as correções estáticas de campo e correções estáticas resi-

duais e estas devem ser aplicadas aos dados para se corrigir dois principais problemas que

são intrínsecos a própria aquisição, mas que causam efeitos indesejáveis nos dados, um deles

é a variação da topogra�a que altera os tempos de trânsito da onda sísmica conforme a sua

variação e também os efeitos da Zona de Baixa Velocidade (ZBV) que atenuam o sinal e tam-

bém o tempo de trânsito das ondas sísmicas. Enquanto que as correções estáticas de campo

são aplicadas ainda no pré-processamento e corrigem efeitos da variação da topogra�a, seus

efeitos nos tempos de trânsitos e também efeitos de intemperismo na ZBV, as correções está-

ticas residuais assim como o processo de análise de velocidade residual, é aplicada nas etapas

de processamento avançado, leva em consideração a de�nição da consistência super�cial e diz

que uma mesma correção estática de tiro em uma determinada posição super�cial, deve ser a

mesma independentemente da posição dos vários receptores e igualmente a correção estática

do receptor em uma dada posição deve ser a mesma para o sinal vindo de vários pontos de

tiros. Geralmente, as correções estáticas só são associadas a dados sísmicos terrestres e não

a marítimos. Embora no processamento desse tipo de dado, desprezam-se duas distorções

1
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passíveis de serem tratadas de forma similar à das correções estáticas. Uma delas é asso-

ciada às profundidades de cabo e da fonte e a outra é uma distorção causada pelas marés.

Dos métodos geofísicos utilizados pela indústria para a obtenção das correções estáticas, o

mais preciso e mais viável economicamente é a de�nição da correção estática a partir das

primeiras quebras dos sismogramas de re�exão, pois as primeiras quebras correspondem as

ondas diretas e as refrações críticas. Fundamentalmente, com o uso das primeiras quebras

dos sismogramas de re�exão a quantidade de curvas de afastamento é muito grande, aumen-

tando assim portanto a redundância de informações sobre a ZBV e esta redundância pode

ser aproveitada por métodos de inversão por mínimos quadrados por exemplo. A qualidade

da de�nição da estática calculada está diretamente relacionada à qualidade da picagem dos

refratores. Softwares avaliam as velocidades médias das primeiras quebras, restritas ao refra-

tor selecionado na picagem, aplicando assim então um deslocamento de tempo adequado, ou

seja, remove o delay originado pela ZBV. A grande maioria dos algoritmos utilizados pelas

companhias de processamento para o cálculo das estáticas residuais se baseia na consistência

super�cial aplicada aos erros estáticos que em conjunto com a grande redundância de dados

adquiridos através da técnica CDP asseguram o sucesso destes processos.



CAPÍTULO 1

Prólogo, Conceitos Básicos e Revisão Teórica

Em geral a parte mais superior da crosta terrestre, o pacote a�orante composto por

material rochoso de espessura variável, lateralmente heterogênea e na qual as velocidades

das ondas sísmicas são muito baixas é conhecido por causar grandes distorções nas ondas

elásticas. É tema recorrente de estudo e a determinação precisa ou aproximada de suas

caraterísticas com o objetivo de se desenvolver métodos cada vez mais e�cazes para reduzir

ou amenizar o seu efeito nos dados sísmicos. Esta porção da crosta terrestre é conhecida como

Zona de Baixa Velocidade (ZBV), Camada de Baixa Velocidade, Zona Intemperizada ou

ainda Camada Super�cial Heterogênea na exploração sísmica e é constituída por rochas total

ou parcialmente decompostas pela a ação de diversos tipos de intemperismo (químico, físico

e biológico) que causam modi�cações profundas nas suas propriedades elásticas originais

. Vale ressaltar que não é a mesma zona de baixa velocidade da geologia que nomeia a

zona próxima a base da litosfera indo até parte da astenosfera, mas sim a parte superior

da crosta onde aqui será comumente abreviada como ZBV. A variação das elevações do

terreno e a geologia próxima à superfície é geralmente muito variável, principalmente devido

a diferenças no grau de intemperismo, aos depósitos super�ciais inconsolidados, à variação

da profundidade do nível freático e principalmente, a ZBV. Os deslocamentos nos tempos

das re�exões, causados pelas variações da topogra�a e da Zona de Baixa Velocidade devem

ser determinados a princípio com precisão, para que os dados sísmicos sejam corrigidos de

efeitos indesejáveis nos dados sísmicos. Essas correções denominadas de correções estáticas,

representam uma das etapas mais importantes do processamento sísmico terrestre já que a

precisão destas correções é um fator limitante da qualidade das seções sísmicas �nais.

1.1 Zona de Baixa Velocidade (ZBV)

O entendimento da ZBV é de suma importância para a aplicabilidade das correções estáti-

cas e também não podemos falar de correções estáticas sem a citarmos. A Zona de Baixa

Velocidade é uma camada intemperizada onde a velocidade das ondas sísmicas são bastante

reduzidas devido a sua caraterística intemperizada e friável e as ondas sísmicas possuem

velocidades da ordem de 200 a 1500 m/s. Isso mesmo, você deve esta se perguntando como
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a ZBV pode assumir velocidades de ondas sísmicas menores do que no ar que é aproxima-

damente 340 m/s. Isso ocorre em regiões onde há muita matéria orgânica em decomposição

e pode ocorrer uma grande quantidade de metano, como ele é muito pouco denso e estando

aprisionado no solo, a pressão aumenta e a velocidade pode cair para níveis sub-sônicos.

Há exemplos disto nos mangues da bacia do Espírito Santo. A ZBV desloca os tempos de

trânsitos registrados originando erros estáticos nos traços sísmicos, gerando um atraso con-

siderável nestes. Na �gura a seguir podemos ver um esboço simpli�cado das camadas da

ZBV.

Figura 1.1: Camadas da ZBV. (Souza, W. E. 2016).

A Z.B.V. representa um pacote litológico a�orante, localizado imediatamente abaixo da

superfície terrestre geralmente composta por uma ou mais camadas de material intemperi-

zado e com espessura total variando desde poucos metros até centenas de metros, podendo

se estender até o nível freático, quando este é existente a ZBV obviamente pode ainda ser

inexistente, em regiões onde o embasamento a�ora por exemplo. Representa um meio geoló-

gico composto por uma ou mais camdas de material rochoso, proveniente da decomposição

parcial ou total de rochas. São características da ZBV provocar forte atenuação nas ondas

sísmicas quando comparadas em rochas não intemperizadas, é um meio que possui grande
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heterogeneidade lateral e vertical provocando deformações na frente de onda a medida que

esta se propaga e ser um meio bastante dispersivo e bastante heterogêneo. A ZBV por essas

propriedades, causa uma forte atenuação na propagação das ondas sísmicas por ser um meio

bastante dispersivo e heterogêneo, aliada às variações topográ�cas da superfície terrestre, no

conjunto acabam produzindo deslocamentos nos tempos de chegada das re�exões mais pro-

fundas, que podem deteriorar a qualidade das seções sísmicas, caso não sejam corrigidos, a

ponto de comprometer um investimento feito por exemplo além de di�cultar por consequên-

cia a interpretação dos resultados e/ou induzir a interpretações errôneas das camadas em

subsuperi�cíe.

1.2 Efeitos da ZBV e Topogra�a nos Tempos das Re�exões Sísmicas

e Correção Estática

Os deslocamentos nos tempos de chegada das re�exões sísmicas causados pelas variações

tanto da topogra�a quanto da ZBV devem ser corrigidos corretamente e por isso precisam

ser determinados com precisão para que isto ocorra.

É sábido que a superfície terrestre apresenta variações de topogra�a/elevação para pon-

tos distintos e como a Zona de Baixa Velocidade pode ser bastante heterogênea tanto em

termos de espessura quanto em termos de velocidade de propagação das ondas elásticas, os

tempos de chegada das re�exões não serão os mesmos para diferentes posições de fonte e

receptores. Para um leigo ou para um estudante ou pro�ssional menos habituado com o pro-

cessamento de dados sísmicos pode se fazer a seguinte pergunta: "Quando e como vou saber

quando aplicar as correções estáticas de campo e residual nos dados sísmicos?"Bom, para o

primeiro questionamento como já foi dito as correções estáticas devem ser aplicadas quando

há variações tanto da topogra�a quanto da espessura da ZBV ou os dois casos. O que signi-

�ca que simplesmente a presença da Zona de baixa Velocidade não implica necessariamente

o uso das correções estáticas, outra coisa a saber é que se a variação topográ�ca for muito

suave a longo dos o�sets os erros estáticos poderão ser muito pequenos ou até desprezíveis

de maneira que a correção não será aplicada. Já a segunda pergunta que é como saber que a

estática deverá ser aplicada pode ser facilmente respondida com a análise dos sismogramas

de tiro, a partir das análises das primeiras quebras, e também das re�exões ou seja, se as pri-

meiras quebras e/ou re�exões estiverem bastante ou pouco distorcidas(não alinhadas e/ou

não lineares) signi�ca que seus tempos foram distorcidos pelos efeitos da topogra�a e/ou

ZBV. Para um estudante mais desavisado também é comum questionamentos como: Porque

a estática não é aplicada aos dados sísmicos marinhos? Bom, para estes questionamento é

bom lembrar inicialmente que no caso de dados marinhos a crosta é oceânica e não conti-

nental, sendo a primeira citada mais densa, em segundo lugar há uma espessa camada de

água água sobre o assoalho oceânico quando em grandes profundidades, o que nos arremete
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automaticamente a não existência de uma zona de baixa velocidade como no caso dos dados

sísmicos terrestres, nos dados sísmicos marinhos a velocidade sísmica menor já é da ordem de

1500 m/s aproxidamente, dependendo das condições de temperatura e salinidades em cada

região, o que já é automaticamente no limiar para ser considerado como uma zona de baixa

velocidade. Outra coisa que deve ser pensada é a questão da topogra�a que não varia no

caso dos dados marinhos, pois os geofones �cam ao nível do mar na superfície, enquanto que

as fontes a cerca de 6 a 9 metros de profundidade aproximadamente, logo já da pra se ter

idéia de porque as correções estáticas só são geralmente aplicadas a dados terrestres, mas na

verdade também são aplicadas a dados marinhos para corrigir efeitos como os provocados

pelas marés por exemplo. Com a �nalidade de deixar mais claro o que ocasiona ao traço

sísmico a variação da topogra�a e da ZBV é mostrado na �gura seguir uma explanação.

Figura 1.2: Efeitos da topogra�a e da ZBV em um re�etor horizontal. Extraído de

Correções Estáticas (AMORIM e SANTOS, 2007).

1.3 Correções Estáticas e ZBV

A ZBV pode apresentar heterogeneidades laterais de pequena e grande extensão. Quando

as heterogeneidades laterias são pequenas comparadas ao tamanho do lanço utilizado du-

rante a aquisição, ou seja, de pequena extensão, os erros produzidos são denominados de

componentes de curto período e causam diminuição da qualidade das re�exões e di�cultam
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a determinação das velocidades de empilhamento. Já aquelas maiores que o comprimento

do lanço, ou seja, as componentes de longo período causam geralmente distorções na inter-

pretação estrutural em subsuperfície, podendo tanto mascarar estruturas verdadeiras quanto

�criar� estruturas falsas. Assim, os métodos de de�nição das correções estáticas para serem

e�cazes precisam ser capazes de representar tanto as anomalias de curto período quanto as

anomalias de longo período.

Cada um dos traços sísmicos apresentam um erro estático relacionado a fonte e outro

relacionado ao receptor. Para isso são necessárias informações como a velocidade da ZBV,

espessura, bem como da elevação em cada ponto de tiro e receptores, além da velocidade da

rocha subjacente logo após a zona de baixa velocidade, ou subzbv. Somente com esses dados

é possível calcular as correções estáticas para um datum qualquer com certa precisão.

Os métodos para a determinação das correções estáticas tem evoluído desde a época

em que poderiam ser obtidos através de cargas colocadas abaixo ou na base da ZBV e os

receptores na superfície permitiam registrar o tempo "up-hole". Dentre os métodos geofísicos

mais utilizados pela indústria para a obtenção das correções estáticas: estão os levantamen-

tos poço acima (up-hole), os levantamento de refração rasa que são chamados de métodos

especias e também as primeiras quebras dos sismogramas. O levantamentos especiais de

refração rasa e/ou de "up-hole"foram durante muito tempo os métodos utilizados para a

determinação das correções estáticas. Os levantamentos de poço acima é o mais preciso de

todos, mas possui uma grande desvantagem de ser inviável economicamente é um método

muito caro porque precisa se fazer furos de sondagem em cada ponto de tiro, já os métodos de

refração rasa apesar de ser muito preciso também assim como os levantamentos de �up-hole�,

possuem limitações onde a ZBV é muito espessa devido as limitações fonte-receptor, além

de exigir uma equipe extra nas aquisições e diversos experimentos aproximando ao custo de

uma aquisição sísmica comum.

Porém, o uso de fontes super�ciais com longos arranjos de fontes e receptores tornaram

a determinação das correções estáticas de maneiras menos direta, não obstante o desenvol-

vimento de trabalhos de alta resolução tem exigido correções cada vez mais precisas Devido

a isso e os custos adicionais de aquisição, aliados a distorções destes levantamentos, levaram

ao desenvolvimento de técnicas do cálculo das correções estáticas baseadas ou a partir do

próprios sismogramas de re�exão. Dos métodos geofísicos utilizados pela indústria para a

obtenção das correções estáticas, o mais preciso e mais viável economicamente é a de�ni-

ção da correção estática a partir das primeiras quebras dos sismogramas de re�exão, pois

as primeiras quebras correspondem as ondas diretas e as refrações críticas, ou seja, trazem

informações sobre a velocidade da ZBV nos afastamentos o�sets mais curtos e informações

sobre a velocidade da subZBV para os mais longos, a depender da distância fonte receptor

é claro, que são os parâmetros necessários para o cálculo das espessuras das espessura em,

subsuperfície. Fundamentalmente, com o uso das primeiras quebras dos sismogramas de
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re�exão a quantidade de curvas de afastamento é muito grande, aumentando assim portanto

a redundância de informações sobre a ZBV e esta redundância pode ser aproveitada por

métodos de inversão por mínimos quadrados por exemplo.

1.4 Fatores que alteram a topogra�a e a ZBV

A princípio não é pensado que ao longo do tempo atividades humanas ou efeitos naturais

podem alterar tanto a topogra�a como a ZBV de forma que quando forem feitos outros

levantamentos em épocas diferentes ou em anos posteriores para a mesma região essas alte-

rações podem provocar efeitos indesejáveis diferentes e muito vezes não esperados. Alguns

parâmetros associados com a superfície e com a região da ZBV podem mudar com as esta-

ções dos receptores ou com o tempo. Resultado de fatores como mudanças de temperatura,

precipitação, vento, erosão recente e deposição, terremotos, atividades vulcânicas e ainda

atividades humanas (Cox, 1999). Logo essas ter a prévia dessas informações é importante

para se manter a qualidade dos dados de aquisições sísmicas futuras por exemplo.

1.5 Determinações dos datuns e as correções estáticas

As de�nições dos datuns para a correção estática é muito importante. O datum �utuante

é estimado como sendo um nível de referência que varia suavemente ao longo das linhas

sísmicas e o objetivo de ter os dados no datum �utuante é a minimização dos erros estáticos

melhorando processos como a análise de velocidade e a correção de NMO. O datum �nal

é normalmente de�nido com base em uma média das correções estáticas totais dos traços

sísmicos que compõem o agrupamento CMP. Frequentemente é comum no processamento

sísmico a mudança dos dados para os datuns para se realizar os processos e após isto estes

voltam para o referido datum a ser aplicado nos processos posteriores. A �gura a seguir da

uma noção maior da importância da de�nição dos datuns.
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Figura 1.3: Podemos ver o datum �utuante em destaque como linha tracejada que

pode ser maior ou menor que as posições da fonte e dos receptores e

por isso pode ser positivo (somar um tempo por estar acima da linha

dos receptores) e negativo (subtrair os tempos por estar abaixo da linha

dos receptores). Extraído do site inter-geo.org

Para o caso do presente trabalho foi adotado o datum �nal para a Bacia do Recôncavo

como 0 m (nível do mar).

Na �gura a seguir mostra um grá�co da topogra�a do terreno, do datum �utuante e do

datum �nal da linha sísmica real utilizada neste trabalho.
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CAPÍTULO 2

Etapas do Fluxo de Processamento Sísmico

Terrestre

2.1 Aquisição de dados

Segundo informações extraídas do relatório do observador (RO), a aquisição do dado foi

feita pela empresa PETROBRAS S.A. no ano de 1994 onde foi empregada fonte explosiva

do tipo bananas de hidrogel que fornecem grande energia, com peso de cerca de 2,5 a 5

kg e enterradas entre 1 a 3 m de profundidade. O dispositivo utilizado na aquisição foi

um lanço bipartido (split-spread) assimétrico com distribuição de afastamentos 2025-50-0-

50-4025 metros conforme a �gura a seguir.

Figura 2.1: Parâmetros de aquisição como lanço, estações, canais e disposição do

arranjo

Foram utilizados 240 receptores por tiro para a aquisição e feitos 326 tiros com razão

de amostragem de 2 ms correspondendo a um comprimento total para a linha de 13.150

km. O tempo de registro foi de 5 s, conforme a tabela 1. A Figura 2 mostra a localização

geográ�ca da linha sísmica 26-RL-1993 na Bacia do Recôncavo. Maiores informações podem

ser consultadas na tabela abaixo:

11
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Descrição Paramêtro

Lanço Bipartido (split-spread) Assimétrico

Distribuição de Afastamentos 2025-50-0-50-4025 (m)

Instrumento de Registro SN-368

Intervalo entre Receptores 25 m

Intervalo entre Tiros 25 m

Número de Tiros 407

Número de Canais 240

Razão de Amostragem 2 ms

Registros 326

Grau de Cobertura 120 ou 12000%

Extensão Total do Registro 13.150 km

Tempo de Registro 5 s

Figura 2.2: Localização geográ�ca da linha sísmica 26-RL-1993 na Bacia do Recôn-

cavo (destacada em vermelho). Modi�cada do site Brasil Rounds-ANP.

2.2 Processamento dos Dados

Aqui serão discutidas as principais etapas do processamento de dados sísmicos terrestres,

exceto a etapa da estática que aplicada a linha processada será discutida no capítulo 4. O

�uxo seguido para o processamento pode ser visto a seguir.
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2.3 Pré-Processamento

2.3.1 Geometria

Feita a conversão para o formato do software onde o dado será processado, segue então a

etapa da criação da geometria, onde informações contidas no relatório do observador (RO) e

nos arquivos de coordenadas (UKOOA) permitem o georreferenciamento do dado. É nesta

etapa que são feitas as amarrações das informações (coordenadas) da (s) fonte (s) e de seus

receptores, do espaçamento entre eles, das elevações dos mesmos, do arranjo utilizado bem

como o número de tiros dados no levantamento. Essa fase do processamento é primordial

e exige bastante atenção do usuário, pois qualquer erro cometido no preenchimento da ge-

ometria será replicado em processos posteriores. A geometria nos possibilita organizar e

manipular dados em outros domínios tais como: domínio do receptor, do tiro, do CMP, do

o�set comum; que permitem a execução do processamento de maneira satisfatória.

2.3.2 Edição

A fase de edição é um controle de qualidade feito no domínio do tiro para eliminação de tra-

ços que possam vir a comprometer os resultados como por exemplo, traços muito ruidosos e

com uma baixa razão sinal ruído ou traços com amplitude nula causados por ruídos externos

ou problemas e mal funcionamento dos receptores. A eliminação do traço deve ser evitada

nos casos em que este contiver informações de amplitudes que podem representar re�exões,

então cabe ao usuário julgar quando eliminar um traço ou não a depender de suas condições.

É possível substituir traços deletados através de uma interpolação de traços vizinhos depen-

dendo do pacote ou do software que se esteja utilizando no processamento. Nesta etapa é

feito o silenciamento ou mute de traços acima das primeiras quebras; refração quando em

dado terrestre ou re�exão do fundo do mar quando em dado marinho. É recorrente o uso de

silenciamentos ou mutes também em etapas do processamento avançado como na correção

de NMO que será citada posteriormente.

2.3.3 Filtragens I

As formas de onda de interesse na geofísica são uma combinação de sinal e ruído. O sinal é

a parte de onda relacionada às estruturas geológicas e o ruído todos os outros componentes

presentes no registro que não são de interesse. Os ruídos ainda podem ser classi�cados como

aleatórios e coerentes; os aleatórios são geralmente associados a eventos relacionados com as

operações de aquisição geofísica como ruídos provocados pelo tráfego de veículos próxima a

área do levantamento e os coerentes estão associados própria fonte sísmica como as ondas

super�ciais geradas por ela.
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Dentre desse aspecto quanto mais atenuarmos os ruídos maior será a nossa razão sinal/ruído

e, portanto, melhor será a imagem �nal da subsuperfície. Os dois tipos principais de �ltros

utilizados são os �ltros de frequência e os �ltros inversos. No presente trabalho foi utilizado

no pré-processamento os �ltros inversos como deconvolução spike e balanceamento espectral,

já no processamento avançado foi aplicado os �ltros de frequência passa banda ou passa faixa

(8-12-50-70) e um �ltro para atenuação de ruídos aleatórios (Fx Decon).

Deconvolução

A deconvolução é um importante passo no processamento de dados sísmicos e frequentemente

aplicada para aumentar a resolução temporal ou vertical dos traços sísmicos. O que a

deconvolução faz é uma compressão no pulso; transforma um pulso básico em um impulso,

desfazendo assim a ação do pulso sobre o traço sísmico e recuperando dessa forma a resposta

impulsiva da Terra; removendo efeitos de reverberação no dado.

Balanceamento Espectral

Já a técnica do balanceamento espectral ou branqueamento espectral segundo Yilmaz (1987)

é muito boa para atenuação de ruídos de alta energia, logo podemos prever a sua e�cácia para

um ruído ambiental comum em linhas terrestres como o ground roll que possui alta amplitude

e baixa frequência. Apesar de não ser um método de deconvolução o balanceamento espectral

pode ser considerado como uma aproximação de uma deconvolução de fase zero pois a sua

aplicação altera apenas o espectro de amplitude e não acasiona modi�cações signi�cativas

na fase do sinal (Silva e Porsani, 2006); é uma técnica monocanal que equaliza a amplitude

de todos os componentes da fase do sinal dentro da banda de frequência registrada. A

Figura 6 abaixo ilustra um sismograma antes da aplicação das técnicas de deconvolução e

balanceamento espectral em (I) após a aplicação das mesmas em (II).



16

F
ig
ur
a
2.
4:

Si
sm

og
ra
m
a
an
te
s
da

ap
lic
aç
ão

do
s
pr
oc
es
so
s
de

de
co
nv
ol
uç
ão

e
ba
la
nc
ea
m
en
to

es
pe
ct
ra
l(
I)
e
ap
ós

a
ap
lic
aç
ão

(I
I)
.



17

2.3.4 Correções de Amplitude I

As ondas sísmicas ao se propagarem no interior da terra sofrem efeitos que reduzem sua

energia e atenuam o sinal (decaimento da amplitude) na qual podemos citar por exemplo:

o efeito da absorção, da divergência esférica ou espalhamento geométrico e das perdas de

energia por transmissão entre outros efeitos (Abreu, 2005). Devido a isso faz-se necessário a

importância de uma etapa conhecida como correção ou balanceamento de amplitudes. Seu

objetivo é compensar, dar um ganho ou recuperar amplitudes do sinal e quando necessário

atenuar amplitudes que podem vir a ser anômalas. Isto é feito para visualizar melhor as

re�exões mais profundas ou até as rasas no caso de serem contaminadas por amplitudes

anômalas.

No presente trabalho foi aplicado uma atenuação de spikes no pré-processamento e

no processamento avançado um levantamento e recuperação da amplitude pelo efeito da

divergência esférica, através de um módulo que será falado adiante devido a este depender das

velocidades nas camadas; e quando necessário ganhos de amplitude nas seções para melhorar

a visualização na aplicação de processos e de seus resultados. O método da Atenuação

de spikes no pré-processamento foi utlizado para uma atenuação de amplitudes anômalas

onde amplitudes que estejam acima da maior amplitude absoluta podem ser zeradas ou não

computadas na estatística. É um balanceamento de amplitude bom para se atenuar ruídos

não consistentes em superfície e as vezes devido ao seu carácter de aplicação anteriormente

citado, funciona também para ruídos que tenham grandes amplitudes como é o caso do

ground roll.

Figura 2.5: Sismogramas de tiro 301 e 321 sem a aplicação do AGC
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Figura 2.6: Sismogramas de tiro 301 e 321 com a aplicação do AGC

Figura 2.7: Sismogramas de tiro 1, 21 e 41 sem a aplicação do OAR.
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Figura 2.8: Sismogramas de tiro 1, 21 e 41 com a aplicação do OAR.

2.4 Processamento Avançado

2.4.1 Análise de velocidade

A análise de velocidade é uma das etapas mais importantes do processamento sísmico, pois

essa fase está diretamente ligada ao sucesso do processamento visto que é nela que deter-

minamos as velocidades das camadas em subsuperfície e o grau de precisão alcançado nela

determina a qualidade da seção sísmica empilhada e portanto também os produtos posteriores

como a seção migrada por exemplo. Nesta fase é feita uma de�nição das funções-velocidade

que melhor compensam as diferenças de sobretempo normal (NMO), das re�exões, ou seja,

de�nir as velocidades que melhor horizontalizam cada re�exão.

Para a determinação das velocidades são marcados os pontos que possuem a maior coerência

possível, ou semblance, (região de maior energia), procurando também um trend de veloci-

dades, (tendência de velocidades, orientação geral). Porém ao se marcar ou de�nir os pontos

pelo trend de velocidades, deve-se observar se realmente os re�etores foram horizontalizados,

pois isso pode variar dependendo de certos ambientes e condições. Na Figura 7 (I) é mos-

trado um semblance, com pontos interpretados segundo a coerência de regiões com maior

energia, e em (II) é mostrada a aplicação da correção de NMO, assunto que será discutido a

seguir. A análise de velocidade é uma etapa que deve ser executada mais de uma vez para um

re�namento melhor das informações e é comum devido a isso evidenciá-la como análise de
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velocidade preliminar e análise de velocidade residual, onde ambas foram feitas no presente

trabalho.

Figura 2.9: Análise de velocidade em um CDP qualquer em (I). Em (II) vemos a

aplicação da correção de NMO, já com aplicação de mute.

A partir de uma interpolação linear dos resultados das análises de velocidade dos CDPs

avaliados, podemos obter o campo de velocidade RMS, mostrado na �gura 8.
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Os traços vermelhos na parte superior da �gura 8 se devem aos painéis que foram

analisados para a geração do campo RMS durante análise de velocidade. Lembrando que

como o campo é RMS ou seja as velocidades são médias quadráticas e não intervalares a

associação direta a litologia pode ser feita, mas obviamente não corresponderá exatamente

aos valores em cada tempo e ponto exatamente por este campo ser de velocidades RMS e

não intervalares.

2.4.2 Correção de NMO

A correção de NMO é uma correção dinâmica por assim dizer, devido a ser uma correção

que varia em função do tempo de re�exão. É feita para que um mesmo evento esteja em

fase para que futuramente se possa empilhar os traços corretamente. Os receptores mais

distantes da fonte terão um tempo maior, ou seja, o�sets maiores tem um tempo maior de

propagação da onda sísmica, então o que a correção de NMO faz é corrigir esses eventos para

um mesmo tempo, como se fonte e receptor estivessem no mesmo ponto, ou seja, como se o

percurso do raio tivesse incidência normal, ou caso de afastamento nulo (zero ofsset). Feita

então essa correção podemos empilhar estes dados, após de�nir um mute ou silenciamento.

Pois na correção de NMO, acontece um efeito chamado de estiramento do traço (stretch),

ou seja, o traço é esticado devido a ser retirado um tempo o que ocasiona sujeira e um

rebaixamento da frequência e quanto maior for o o�set maior será esse efeito. Então um

mute ou silenciamento, que pode ser automático ou manual deve ser desenhado e executado

para minimizar este efeito. Na Figura 7 (II) acima ao lado do espectro de velocidade podemos

ver a aplicação da correção de NMO e um mute já executado. No dado processado neste

trabalho foi realizada um mute automático e em seguida um manual por cima deste, para

se ter uma maior eliminação do efeito de estiramento na seção.

2.4.3 Empilhamento

O empilhamento ou stack é a soma dos traços de uma família CMP após a correção de NMO.

Onde todos os traços de cada família CMP são somados resultando em um único traço. Ao

�nal desta fase de processamento já teremos uma primeira imagem da geologia em subsu-

perfície. Sua qualidade dependerá de uma análise de velocidade corretamente executada.

Ao �nal do empilhamento de traços formam a seção que chamamos de seção empilhada, os

CMP's contínuos constituem essa seção sísmica, que é a representação do modelo geológico

em subsuperfície. É um processo que melhora as condições de informações obtidas em cada

traço devido a redundância de informações ressaltando e mantendo portanto o que é mais

coerente e eliminando ou atenuando o que não for. É um processo que funciona como ate-

nuador de ruídos aleatórios, devido ao último princípio citado, que por sua vez aumenta a

razão sinal/ruído.
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2.4.4 Migração

A migração é um importante e essencial processo que pode ser aplicado antes do empilha-

mento (pré-stack) e/ou após o empilhamento (pós-stack). A migração pode ser de�nida

como um método de focalização da energia sísmica pois ela recoloca a energia espalhada na

posição do ponto espalhador, normalmente chamado de difrator. É a etapa que corrige os

efeitos de mergulho das camadas, movendo-as para suas posições verdadeiras, colapsando as

difrações e aumentando assim a resolução espacial da seção. Pode ser também em tempo

ou em profundidade e portanto pode ser feita em diferentes etapas do processamento. No

presente trabalho foi feito a migração Kirchho� pré-stack em tempo que pode ser vista na

Figura 10.

2.4.5 Correções de Amplitude II

As correções de amplitude se fazem necessárias devido à perda de energia e a atenuação do

sinal sísmico com o tempo de propagação no interior da terra, que acontece por vários fatores,

onde citaremos dois destes processos. A Divergência esférica ou espalhamento geométrico,

que é o decaimento da amplitude devido ao espalhamento da frente de onda e a Absorção que

é o decaimento de densidade de energia da onda, onde ocorre dissipação, que é a conversão da

energia elástica em calor. Essas correções feitas não foram como as anteriores (I) apenas para

se visualizar os dados, após a aplicação das mesmas estas foram salvas. Os balanceamentos

de amplitudes ou correções de amplitude feitos durante o processamento foram o OAR,

(O�set Amplitude Recovery) e o TAR (True Aplitude Recovery) na seção empilhada, ambos

corrigem os efeitos da divergência esférica e utilizam o campo de velocidades para o cálculo,

na tradução literal dos termos OAR e TAR seriam: Recuperação da Amplitude com o O�set

e Recuperação da Amplitude Verdadeira.

2.4.6 Filtragens II

O objetivo nos processos de �ltragem é fazer uma limitação das bandas de frequência pre-

sentes no dado. São eliminados dos traços componentes de frequência muito altas ou muito

baixas e assim contribuindo para uma melhora signi�cativa na razão sinal/ruído. Filtragens,

obviamente, serão aplicadas após a identi�cação do ruído a ser atenuado e podem ser apli-

cadas ou feitas tanto no domínio do tempo quanto no domínio da frequência. Os �ltros de

frequência são geralmente empregados nos dados pós stack. Como exemplo temos o �ltro

passa faixa ou passa banda, que permite a passagem de frequências de certa faixa e rejeitam

(atenuam) as frequências fora dessa faixa. Essa faixa é de�nida com a determinação dos

slopes do �ltro que são inclinações da curva de Frequência versus Amplitude. Eles de�nem

o intervalo de atuação do �ltro corta-baixa ou passa-baixa e o corta-alta ou passa-alta, onde
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serão cortados os valores de frequência. Entre os slopes as frequências são preservadas e

antes do corta baixa ou depois do corta alta elas são atenuadas no presente caso o �ltro

utilizado foi um do tipo 8-12-50-70 (Hz). Outro exemplo é o �ltro Fx Decon, que é um �ltro

usado para atenuar ruídos aleatórios que são ruídos não coerentes, externos e não associados

a fonte, no pós empilhamento, utilizando-se do princípio matemático da transformada de

Fourier.
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CAPÍTULO 3

Aplicação em Dados Sintéticos

Os modelos sitéticos foram criados no Software ProMAX/SeisSpace da Landmark-

Halliburton, utilizando o módulo Finite Di�erence Modeling . Foi gerado um sismograma

sintético preliminar que serviu de entrada para criação do sismograma sintético �nal. Nesse

sismograma sintético preliminar foi escolhida a opção da Wavelet e de�nido parâmetros como

o�set mínimo e máximo, números de tiros e etc. Depois disso modelar e/ou criar/editar um

campo de velocidade com os horizontes, estruturações e velocidades das camadas a escolha

e por último gerar o seu sismograma sintético �nal pelo método das diferenças �nitas. Em

outras palavras foi necessário gerar um sismograma preliminar qualquer com a uma geome-

tria já escolhida para a de�nição do campo de velocidades já que a entrada para o mesmo

são os números de CDPs logo é preciso que a geometria já esteja de�nida para esta etapa.

E então depois gerado o campo de velocidades para geração do dado sintético �nal. Maiores

informações de como foi feita a modelagem podem ser consultadas ao �nal deste trabalho

nos anexos um tutorial.

Foram criados 4 modelos, cada um com duas camadas e o embasamento, o modelo

1 tem topogra�a e base da ZBV planas, o modelo 2 tem topogra�a variando e base da

ZBV plana, o modelo 3 tem topogra�a plana e base da ZBV variando e o modelo 4 tem

topogra�a e base da ZBV variando. Todos os modelos possuem velocidade constante na

primeira camada e também no embasamento, e um gradiente de velocidade na segunda

camada com sensibilidade de 4 metros de profundidade do topo até a base do modelo. A

topogra�a utilizada nos modelos 2 e 4 é a topogra�a real de uma linha sísmica da Bacia

do Recôncavo e o gradiente na segunda camada é também a aproximação da resposta da

sub-ZBV da Bacia do Recôncavo. Para criar este campo são necessários criar os horizontes

que de�nirão as interfaces entre as camadas. Foram criados então três horizontes para os

quatro modelos. Um horizonte a 30 metros de profundidade e plano, um segundo horizonte

variando sua profundidade de 30 a 50 metros de profundidade que depois fora suavizado, com

um comprimento de onda λ até a metade do horizonte e depois a um comprimento de onda

2λ e um terceiro horizonte para marcar a interface base da Sub-ZBV com o embasamento

na profundidade de 900 metros, conforme serão mostrados em �guras a frente. Com relação

ao processamento desses dados, foram feitos etapas como: a geometria, edição com mutes

internos e externos para onda direta, efeitos de borda e para o próprio estiramento do traço,

26
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correção estática de campo e quando preciso residual, organização em CMP, correção de

NMO, análise de velocidade e empilhamento. A modelagem feita utilizou os princípios das

diferenças �nitas e levou em consideração como modelo acústico de velocidade e não elástico,

de maneira que efeitos indesejáveis como o cone de Ground-roll provocadas pelos efeitos das

ondas super�ciais não fora gerado, como poderá ser notado nos sismogramas de tiros. Para os

cálculos das correções estáticas de elevação foi usado como datum o nível do mar (0 m), que

é geralmente o datum utilizado na industria para dados sísmicos da Bacia do Recôncavo.

Já para os cálculos da estática de intemperismo ou refração foi utilizado a velocidade de

reposição de V=2600 m/s.

3.1 Modelagem Sísmica

Como já é de nosso conhecimento a modelagem sísmica envolve a produção de sismogramas

teóricos (sintéticos), para sequências acamadadas com o objetivo de se investigar os efeitos da

variação dos parâmetros do modelo sobre a forma dos sismogramas resultantes. Tanto seções

sísmicas quanto sismogramas sintéticos podem ser comparados com dados observados, e os

modelos criados podem então ser manipulados para simular dados observados. Das razões

para se criar modelos sintéticos podemos citar por exemplo: projetar um levantamento

sísmico, avaliar diferentes estruturas de processamento, testar a e�cácia de diferentes técnicas

de captura de imagem e analisar a sua aplicabilidade ou ainda criar seções pseudossísmicas

a partir de dados de per�lagem.

Com a notável expansão na velocidade e na capacidade dos computadores digitais e sua am-

pla disponibilidade, um método cada vez mais importante de interpretação de refração é uma

técnica de modelagem conhecida como traçado de raios (ray-tracing) (Cerveny et al., 1974).

No método do traçado de raios, modelos estruturais hipotéticos são então construídos e os

tempos de percurso de raios refratados (e re�etidos) através desses modelos são calculados

por softwares para comparação com os tempos de percursos observados. É particularmente

útil no caso de estruturas complexas em subsuperfície e que de modo analítico são difíceis

de tratar e é especialmente valioso no tratamento de cenários complexos, como gradientes

de velocidades verticais e/ou horizontais dentro de camadas, camadas descontínuas ou ainda

interfaces refratoras altamente irregulares ou com grande mergulho. Um exemplo de mode-

lagem por traçado de raios pode ser conferido no lado direito da Figura 13 usando o Cshot

que usa esse princípio para geração de modelos sintéticos.

Já o método de diferenças �nitas tem como base aproximações das derivadas da série de Tay-

lor por truncamento, e possui limitações em relação a estabilidade e dispersão e normalmente

funciona para intervalos temporais pequenos. Assim como o método de traçado de raios, o

método das diferenças �nitas é particularmente muito bom para modelagem de geometria

de estruturas complexas em subsuperfície, devido às grandes di�culdades encontradas em
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obter soluções analíticas. O interesse nos modelos criados pelo método das diferenças �nitas

da equação da onda tem abordado questões em razão do grau de correlação entre a solução

de diferenças �nitas e a obtida pelos métodos clássicos quando comparado com a teoria dos

raios. O problema da propagação da onda é resolvido teoricamente para um meio in�nito,

embora por causa da manipulação numérica computacional dos parâmetros do modelo fí-

sico, soluções por diferenças �nitas podem ser obtidas somente para um número �nitos de

pontos. E devido a isso é necessário utilizar um modelo �nito, o que implica na introdução

de fronteiras arti�ciais o que produz eventos espúrios como re�exões de borda. Como, o uso

dessas fronteiras arti�ciais não pode ser desprezado na geração de sismogramas sintéticos por

diferenças �nitas, é necessário se fazer a procura de outras condições de fronteira adicionais

que reduzam as re�exões nas bordas.

3.2 Dados Sísmicos Sintéticos

3.2.1 Modelo 1

O modelo 1 foi tomado como topogra�a plana e base da ZBV plana. A espessura da primeira

camada ou seja da ZBV adotada foi de 30 m, com uma velocidades sísmica constante de

800 m/s. Já a segunda camada, interface Sub-ZBV com o embasamento possui 870 m de

espessura e tem um gradiente de velocidade de V=2600 + 0,6.z, onde z é a profundidade, esse

gradiente foi usado para se aproximar mais das condições reais da Bacia do Recôncavo. E

por último o embasamento também com velocidade constante de 4500 m/s e com espessura

de 100 m. Na �gura a seguir podemos ver o campo de velocidade intervalar que foi usado

para geração do dado sintético conforme informações citadas anteriormente.
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Agora a resposta de um sismograma de tiro para este modelo mostrando os eventos

como onda direta, re�etidas e refratada.
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Neste modelo não foi aplicado as correções estática porque simplesmente não é neces-

sário a aplicação da mesma. Veri�cando o sismograma de tiro já vemos de cara que não há

erros estáticos nas primeiras quebras, pois estes últimos estão perfeitamente bem alinhados

e lineares como era de esperar para o modelo. Na �gura a seguir podemos ver o campo de

velocidade intervalar que foi usado para geração do dado sintético.

Para a análise de velocidade neste modelo e em todos os outros três foram marcados

apenas dois picks (pontos), que são relativos a primeira re�exão na primeira camada e a

segunda re�exão na interface base da Sub-ZBV e o embasamento. Em sequência temos

campo de velocidades rms para este modelo, conforme �gura a seguir.
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Para todos os modelos foram feitos mutes internos e externos antes do empilhamento,

isto para a onda direta, para o efeitos de borda e também para o efeito de estiramento do

traço após a aplicação da correção de NMO. Nas �guras seguintes serão apresentadas essa

aplicação de mute e a própria seção empilhada com essas edições.

Figura 3.5: Seção de o�set comum com a aplicação de mutes internos para a onda

direta e os efeitos de borda ocasionados pela modelagem por diferenças

�nitas.
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A conclusão que podemos ter é que quando a topogra�a do dado é plana e base da

ZBV também é plana não é necessário a aplicação das correções estáticas. Ou seja de

maneira geral a ZBV pode até atenuar a energia da onda sísmica, mas se sua interface for

plana nenhum re�etor será prejudicado ou nenhum efeito indesejável será criado, em outras

palavras a presença da ZBV não é um fator que compromete a qualidade da seção sísmica,

mas sim a sua variação de espessura conforme veremos em modelos posteriores.

3.2.2 Modelo 2

Para o modelo 2 assim como o 3 e 4 as camadas são as mesmas que o modelo 1, ou seja

a ZBV e o embasamento com velocidades constantes e um gradiente de velocidade na Sub-

ZBV, conforme já dito anteriormente, mas a diferença é que nesse modelo há uma variação

da topogra�a que é acentuadamente bem brusca em alguns chegam variar de 135 metros até

60 metros, essa topogra�a não é arti�cial, mas sim uma topogra�a real de uma linha sísmica

da Bacia do Recôncavo que foi também usada neste trabalho a seguir, isso feito para se

aproximar mais ainda as características de modelos reais. O campo utilizado para o modelo

2 foi o mesmo do modelo 1, só que com a topogra�a carregada acima de 0 metros com a

velocidade sísmica da ZBV, ou seja neste caso então a espessura mínima da ZBV é de cerca

de 30 metros (do campo de velocidade 1) mais 60 metros da menor elevação da linha, ou seja

90 metros de espessura mínima de ZBV e com 135 metros mais 30 metros do modelo, dando

aproximadamente 165 metros de espessura de ZBV, isso foi proposital para se apresentar

erros estáticos su�cientemente bons de serem vistos a olho nu, no sismograma de tiro ou até

na seção empilhada mesmo.

Na �gura a seguir podemos ver o tiro 1 para o modelo 2, o "desaparecimento"da onda

direta se deve as variações topográ�cas. Mostrando o que causa o efeito da variação topo-

grá�ca para as primeiras quebras e a re�exão da segunda interface.
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Agora para termos uma ideia maior da importância da estática vamos ver a comparação

entre certos tiros apenas com a geometria e em seguida os mesmos tiros com a aplicação da

correção estática e o plote da elevação acima com sua escala em metros.
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Com a �nalidade de �car mais perceptível os os erros dos sismograma e também da

melhora no alinhamento tanto das primeiras quebras quanto da segunda re�exão a seguir

tem-se a mesma imagem do tiro 10 como efeito de zoom para melhorar a visualização destes

itens anteriormente citados.
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O que já no domínio do tiro podemos dizer com garantia e clareza que os erros estáticos

provocados pela variação topográ�ca foram corrigidos pela estática. Neste caso foi necessário

aplicar tanto a estática de elevação quanto a estática de refração, pois a estática de elevação

não apresentou resultados su�cientes e após a estática de refração as correções foram su�-

cientemente e�cientes como mostrado nas �guras anteriormente. Isso pode ser ocasionado

tanto pelo fato da modelagem �nita utilizada no software não ser boa para usar as elevações

do header ou ainda devido a espessura da ZBV que demasiado grande em alguns pontos de

modo que os erros precisariam ser calculados tanto devido a elevação quanto da espessura

da zona de intemperizada. Na �gura seguir vemos a comparação da seção empilhada com as

correções estáticas de campo e antes da aplicação das mesmas.
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Com isso podemos tirar como conclusão que como previsto em regiões onde a topogra�a

varia bastante ou bruscamente conforme o levantamento vai sendo feito, os erros estáticos são

grandes já em regiões onde a topogra�a varia muito pouco ou suavemente os erros estáticos

são tão pequenos a ponto de não serem percebidos nos sismogramas de tiro ou até talvez

nas seções empilhadas. Coincidentemente na região de maior variação da topogra�a é onde

a ZBV também é mais espessa o que aumenta os erros provocados pela atenuação da energia

sísmica conforme pode ser notado nas seções empilhadas anteriores. A �gura a seguir mostra

a topogra�a da linha sísmica aplicada ao dado sintético do modelo 2 e 4.
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3.2.3 Modelo 3

O modelo 3 é um campo diferente dos modelos 1 e 2, no seguinte aspecto, o horizonte que

faz a interface base da ZBV com a Sub-ZBV não foi mantido mais plano e sim variando ao

longo da profundidade. Esse horizonte começa então a 30 m e varia até cerca de 50 metros

de profundidade, e possui dois comprimentos de onda diferentes um primeiro comprimento

com cerca de 100 cdps até a metade do modelo e um segundo comprimento de cerca de 200

cdps. Esse horizonte foi então mantido e suavizado assemelhando-se a uma senóide para

funcionar como base da camada de baixa velocidade se aproximando mais de um modelo

real por exemplo. Em outras palavras o modelo 3 possui topogra�a plana a nível do mar

(0m)e base da ZBV variando. Na �gura a seguir pode ser notado o campo de velocidade

intervalar feito para simular a geologia para o modelo de número 3.
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Na �gura a seguir é mostrado um sismograma de tiro frisando apresentar os erros

estáticos causados pela variação da espessura da camada de baixa velocidade, observe que a

chave de elevação dos receptores foi plotada acima do sismograma de tiro comprovando que

não há variação topográ�ca e que esta a nível do mar, ou seja, 0 metros.
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Este modelo como só tem base da ZBV variando não foi aplicada a estática de elevação

obviamente e sim apenas a correção estática de campo de refração que se mostrou bastante

e�ciente linearizando as primeiras quebras e melhorando o seguimento das ondas re�etidas

conforme pode ser visto na �gura a seguir, na região com comprimento de onda λ.
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Agora outro sismograma de tiro na região entre o comprimento de onda λ e 2λ para o

re�etor da base da ZBV. Como do lado direito a variação da espessura da ZBV é mais suave

os erros estáticos são menores e por isso do lado direito dos dois sismogramas (com e sem

estática) foi marcado para notar os erros sutis que foram provocados. Observe que do lado

esquerdo como os erros são maiores a percepção a olho nu da não linearização das primeiras

quebras é também maior. Em vermelho esta marcado como deveria ser o prologamento das

primeiras quebras no que diz respeito a linearização.
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E por último o efeito apenas da região com o horizonte da base da ZBV da ordem de

2λ. Em vermelho estão destacadas as primeiras quebras, observe que do lado esquerdo do

sismograma sem a aplicação da estática os erros são maiores do que na direita que é quase

imperceptível, provalvemente isso ocorreu porque o lado direito teve mais in�uência da ZBV

do que na direita, ou seja a direita teve menos espessura da ZBV do que a parte a esquerda

do tiro.
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Agora analisaremos o efeito dos erros estáticos na seção empilhada.
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Podemos concluir do modelo 3 que embora os erros estáticos aparentassem pequenos

consideravelmente no domínio do tiro do lado do re�etor com comprimento de 2λ em relação

ao lado com comprimento de onda de λ , na seção empilhada ambos alteraram o segundo

re�etor de modo a criar falsos re�etores que sequer existiam, o que mostra a excelência da

correção estática para o processamento de dados sísmicos e por consequência para a inter-

pretação, devido aos erros estáticos criarem re�etores que sequer existem comprometendo a

qualidade da imagem sísmica da subsuperfície.

3.2.4 Modelo 4

O modelo 4 nada é mais é do que o campo do modelo 3 com a topogra�a de uma linha sísmica

real ( a mesma usada no modelo2), ou seja, é com topogra�a variando e base da ZBV também

variando, em outras palavras seria como um merge entre os modelos 2 e 3. Diante dessa

informações já sabemos que para este modelo a espessura mínima da ZBV é 90 metros (pois

60 metros de elevação mais 30 metros de espessura da ZBV pelo campo utilizado), e por

conseguinte a espessura máxima é da ordem de 185 metros (pois 135 metros da elevação da

linha + 50 metros de espessura do campo)Este modelo portanto a priori deveria apresentar os

erros mais grosseiros do que todos os outros correto? Não necessariamente, pois alguns erros

gerados com a variação topográ�ca e da espessura da ZBV podem gerar tanto erros estáticos

positivos ou negativos de acordo com a escolha do datum, e por isso não se pode a�rmar

isso de imediato. Em algumas regiões pode melhorar em outras piorar ou muda pouca coisa

e vice-versa, e vai depender se estes erros se somarem construtivamente ou destrutivamente

e etc.. Para demonstrar isso olhe a �gure a seguir com o sismograma do modelo 3 a direita

e do 4 a esquerda.
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Observe que o sismograma da direta apresentou erros estáticos menores provavelmente

os erros da variação topográ�ca que eram pequenos se somaram destrutivamente aos da

variação da espessura da ZBV e por isso tanto as primeiras quebras quanto as ondas re�etidas

se mostraram mais contínuas ou coerentes.

Neste modelo foram aplicadas tanto as correções estáticas de elevação quanto as de

refração (intemperismo), na �gura a seguir vemos o resultado de suas aplicações.
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Podemos ver que os eventos �caram bem mais consistentes coma a aplicação da estática

de campo, agora vamos ver na seção empilhada.
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Com o objetivo de melhorar ainda mais a linearização do segundo re�etor foi aplicada

a estática residual, conforme podemos veri�car no resultado a seguir.
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Observe que uma melhora foi obtida do lado esquerdo da seção empilhada um resultado

claro e perceptível conseguido pela correção estática residual que deve ser aplicada quandos

as correções de campo não são capazes de se corrigir todos os erros estáticos.



CAPÍTULO 4

Aplicação em Dado Real

4.0.1 Correções Estáticas

Dois tipos de correções de tempo devem ser aplicados aos tempos de re�exão nos traços

sísmicos individuais para que esses possam representar corretamente estruturas geológicas

em subsuperfície. São elas as correções estáticas e correções dinâmicas, assim chamadas

porque a primeira é uma correção aplicada no traço a um tempo �xo enquanto que na

segunda varia em função do mesmo. Trataremos aqui das correções estáticas de campo e no

processamento avançado as correções estáticas residuais e correção dinâmica.

A correção estática é uma correção de tempo aplicada aos traços sísmicos de maneira que os

tempos de re�exão �quem referenciados a um datum plano. Estas diferenças de tempo são

introduzidas por irregularidades próximas à superfície como elevações do terreno, variações

da geologia próxima a superfície devido a diferentes graus de intemperismo, aos depósitos

super�ciais inconsolidados e lateralmente heterogêneos e a variação do nível freático que

compõem a camada intemperizada ou Zona de Baixa Velocidade (ZBV). Basicamente a

correção estática não pode ser desprezada em dados terrestres, e geralmente, não é aplicada

a dados marinhos embora duas distorções podem ser passíveis de serem tratadas; como à

profundidade da fonte e dos receptores ou efeitos causados pelas variações do nível do mar

provocada pelas marés (Rosa 2010).

A aplicação das correções estáticas representa a simulação que seria caso fontes e recep-

tores estivessem sobre uma superfície denominada datum, em pontos acima ou abaixo de

suas posições reais, eliminando assim, portanto os deslocamentos produzidos pela variação

da topogra�a e/ou ZBV. Existem as correções estáticas de campo e as correções estáticas

residuais, a primeira associada a correções de intemperismo e elevação levando fonte e recep-

tor para o mesmo datum, que mostraremos resultado a seguir e as residuais que possuem a

função de corrigir erros não resolvidos na estática de campo; que serão discutidas adiante.
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4.1 Comparação Antes e Após a Correção Estática de Campo

Nas �gura seguintes são mostrados a comparação de um sismograma sem a aplicação da

correção estática e após a aplicação da mesma.
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Podemos observar que no lado esquerdo do sismograma (I) da Figura 5, onde a topogra�a

varia mais, há um erro maior da es tática e, portanto, perceptível em II a sua respectiva

correção.

Figura 4.2: Sismogramas com tiros 1, 21 e 41 sem a aplicação da correção estática

de campo.

Figura 4.3: Observe o alinhamento do tempo das primeiras quebras após a correção.

Figura 4.4: Sismogramas com os tiros 221 e 241 antes da aplicação da correção

estática de campo.
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Figura 4.5: Aplicação da correção estática de campo linearizando os tempos de

re�exão.

Figura 4.6: Sismogramas antes da aplicação da correção estática, somente com a

geometria feita nos tiros 301 e 321.

Figura 4.7: Mostrando a aplicação e o efeito da correção estática de campo.
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4.1.1 Estática Residual

Pequenos erros das correções de campo podem ser corrigidos durante o processamento sísmico

através das chamadas correções estáticas residuais.Logo após a análise de velocidade e a

correção de NMO aplicadas já pode-se calcular a estática residual. O objetivo da correção

estática residual é obter ummelhor alinhamento possível de sinais primários em traços de uma

família CMP. Em qualquer trabalho convencional de correções estáticas residuais, considera-

se que os traços sísmicos já tenham sido corrigidos do efeito da estática de campo proveniente

das variações das elevações e da ZBV para cada tiro e estação de receptor da linha sísmica.

Resumidamente podemos dizer que a função da correção estática residual é corrigir erros

não resolvidos somente com a estática de campo. A consistência super�cial signi�ca que os

resíduos de tempo dependem exclusivamente das localizações das fontes e dos receptores na

superfície. São utilizados, horizontes de referência para a aplicação deste processo de modo

a melhorar aos resultados. Esses horizontes citados são marcados nos re�etores que deseja

melhor imagear, observe na �gura abaixo um exemplo de de�nições.
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Podemos ver na �gura abaixo um corte apresentando a comparação sem a aplicação

da estática residual e com a plicação da mesma, para uma região comum. Existem bons

programas para o cálculo das correções estáticas residuais, porém obviamente os melhores

resultados são obtidos quando as estáticas de campo são de alta precisão.
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Podemos concluir que a aplicação da estática residual ressaltou a continuidade do re-

�etor mostrado na �gura anterior.



CAPÍTULO 5

Conclusões

O processamento de dados sísmicos é uma etapa de suma importância para a indústria

do petróleo, pois um dado sísmico bruto de campo não é capaz de imagear corretamente

e claramente a subsuperfície terrestre aplicando apenas uma inversão sem passar por um

processamento adequado antes. O processamento realiza edições, manipulações e principal-

mente correções que a própria aquisição somente não pode, não é capaz ou não é o seu papel

de corrigir.

A modelagem feita não apresentou os erros estáticos esperados talvez por não trabalhar

bem quando se usa as elevações do header, entretanto os erros apresentados foram su�cien-

tes para comprovar a e�cácia e a importância das correções estáticas. A presença da ZBV e

nem pequenas variações de topogra�a especi�camente não garantem que sempre a correção

estática precisará ser usada, e sim apenas quando as variações da topogra�a são grandes e

bruscas ao longo do levantamento sísmico e a espessura da ZBV varie também. Conforme

os resultados apresentados o não uso das correções estáticas podem comprometer um inves-

timento feito, visto que ao criar falsos re�etores a interpretação das seções serão afetadas e

a qualidade da imagem da subsuperfície por consequência também.

Neste trabalho onde foram mostradas as etapas de processamento de uma linha real da

Bacia do Recôncavo, é claro e notório a importância da aplicação de etapas como a edição,

correções de tempo, correção de amplitude, �ltragens, análises de velocidade, empilhamentos

e migrações que aproximaram mais das feições geológicas reais onde deixou mais nítida e

limpa de ruídos as seções.

Como vimos ao longo deste trabalho a aplicação das correções estáticas é de suma

importância para o processamento sísmico de dados terrestres e algumas vezes a correção

estática residual também. Pois a primeira a grosso modo como vimos corrige o efeito da

topogra�a e melhora muito o efeito da ZBV para os tempos de trânsito e a segunda, dado

a de�nição do conceito de consistência super�cial melhora as de�nições dos re�etores as-

sim como os posiciona mais corretamente melhorando muito assim portanto a qualidade e a

con�abilidade da seção para uma melhor de�nição póstuma de possíveis indicações de estru-

turas de prospectos. Favorecendo também a interpretação sísmica ao fornecer seções mais

realistas.
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INTRODUÇÃO

Tutorial criado para ajudar na criação de modelos sintéticos no pacote de softwares

de processamento sísmico ProMAX/SeisSpace. Autoexplicativo possibilita o entendimento

tanto para usuários inexperientes quanto mais experientes com o software. Aqui nos atere-

mos apenas a modelagem em si, então se o usuário não souber como fazer processos como

a geometria será necessário que entenda e aprenda como fazer, pois, é passo vital para este

exemplo de modelagem. Este manual está com uma linguagem muito simples é autoexplica-

tivo de maneira que qualquer leigo tanto em processamento e modelagem ou um usuário sem

nenhuma experiência com o software possa operá-lo exceto a parte da criação da geometria

que aqui não será detalhada, mas vale ressaltar que é importante que antes de começar a mo-

delagem saber conceitos muito básicos como a diferença da modelagem inversa e direta bem

como processamento de dados sísmicos em si e etc. Lembrando que qualquer dúvida sobre

os parâmetros ou coisas especí�cas da parametrização dos módulos deverá ser consultada no

help do próprio Seisspace/Promax indo no �uxo selecionado com o módulo ativo e clicando

no botão F1, você ativa o help, então é só consultá-lo. Outras informações de como operar

o software poderão ser consultadas no manual do mesmo de versões anteriores ou procurar

um usuário já experiente no manejamento do próprio.



89

Passo 1 Como criar o sismograma preliminar que servirá como entrada para a geração

do sintético �nal. O tipo de modelagem executada utiliza o método por diferenças �nitas se

não tiver domínio do se trata é aconselhável que se tenha uma ideia básica antes de iniciar

a modelagem. Para fazer o tipo de modelagem que será ensinada é necessário que antes

você tenha um sismograma qualquer com a geometria já de�nida e depois disso modelar

e/ou criar/editar um campo de velocidade com os horizontes, estruturações e velocidades

das camadas a escolha e por último gerar o seu sismograma sintético �nal pelo método das

diferenças �nitas. Em outras palavras é necessário um sismograma preliminar qualquer com

a uma geometria já escolhida para a de�nição do campo de velocidades já que a entrada para

o mesmo são os números de CDPs logo é preciso que a geometria já esteja de�nida para esta

etapa.

Para criação então da etapa do sismograma preliminar abra o SeisSpace, depois de

criar o Projeto, Subprojeto e etc. Crie um �uxo normal intitulado Sismograma Sintético

ou qualquer nome que você preferir/desejar, lembrando de evitar caracteres especiais como

palavras com acento agudo, circun�exo, til. C com cedilha e etc para os nomes de seus

�uxos, tabelas, datasets e etc.

Figura A.1: Figura1: Mostrando o módulo para construção do sismograma sintético

preliminar.

Pesquise nesse �uxo aberto o módulo Synthetic Trc Generation como mostra a

Figura 1. Selecione este módulo clique com botão 2 domouse (botão central) para con�gurar,

conforme a Figura 2, e preencha as informações a escolha. A con�guração do tipo de wavelet

é a escolha, e no presente caso foi utilizado default (padrão) esta parte, ou seja, como estava,

outra coisa que pode ser deixada default é a fase da wavelet e também os eventos sísmicos na

parte de De�ne ORMSBY Synthetic Seismic Events, já que isso será feito depois utilizando
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outros módulos. O resto você deverá mudar a escolha.

Figura A.2: Figura 2: Parametrização do Módulo de Geração do Sismograma Sin-

tético Preliminar.

Ou seja, depois da parametrização "TYPE of synthetic wavelet"não é necessário mudar

nada a depender do que você deseja fazer e a última parametrização não é necessário fazer,

pois a fará quando tiver editando o campo de velocidade e criará os eventos sísmicos a escolha

e etc.

Depois de con�gurar este módulo insira um nome para dataset a ser criado como forma

de saída com o módulo "Disk data Output", (ddo). Pronto, agora com o botão 2 abra este

módulo e depois na parte de "Output Dataset Filename"clique em Invalid, em seguida clique

com o botão direito e clique em "New ProMAX Dataset". Dê um nome para este dataset

de saída e depois click em Ok. Feche essa janela do (Ddo). Pronto, com os dois módulos

ativos veri�que se os dois estão negritos de acordo com a Figura 3 se não estiverem clique

com o botão direito em cima de cada um deles para ativá-los. Coloque esses dois para

executar ("rodar"/ "correr") clicando no botão central marcado com um triângulo dentro de

um círculo se você colocar o mouse em cima deste botão aparecerá como diálogo "Submit on

this machine"ou ainda pode ser usado a opção Ctrl (no teclado do computador) + botão do

lado, o "Submit using default submit parameters". Ou ainda os dois modos podem funcionar

separadamente a depender da parametrização do software na máquina. Veja o detalhe em

vermelho marcado na Figura 3.
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Figura A.3: Figura 3: Mostrando as opções de como rodar um �uxo a depender da

parametrização do software na máquina.

Figura A.4: Figura 4. Passo para a visualização do dado sintético preliminar.

No mesmo �uxo caso deseje visualizar este sismograma criado desative os módulos

anteriores e adicione oDisk Data Imput clique com o botão direito e em seguida em "Select

dataset"do lado direito em "Invalid"clique e selecione como entrada o Dataset anteriormente

criado. Feche essa Janela e ainda no mesmo Flow, coloque um Trace Display não precisa

mexer em nada. Com esses 2 módulos ativos e outros 2 desativados coloque para rodar

segundo a Figura 4. Ao �nal quando este �uxo rodar aparecerá como saída uma nova janela
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cinza semelhante à Figura 5. A depender da con�guração que você escolheu para o sintético

criado.

Figura A.5: Figura 5. Visualização do Sismograma Sintético Preliminar na opção

de Wiggle Trace.

.

Pronto agora vamos fazer a geometria do seu sismograma sintético e carregá-la. Usando

o módulo 2D Land Geometry Spreadsheet, desative os outros módulos e então depois de

adicionar este coloque-o para rodar. Quando tiver rodado/executado este módulo aparecerá

uma nova janela pequena branca e com letras destacadas em azul semelhante a Figura 6.
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Figura A.6: Figura 6: Módulo para se fazer a geometria para o Sintético Preliminar.

Preencha todas as tabelas de geometria referentes ao arranjo, receptores, fonte, padrão

e por último faça a binagem. Utilizando as caixas de "Setup", "Receivers", "Sources",

"Patterns"e por último "Bin"respectivamente. Para isso indico ler o help e também o

tutorial do software deixando o módulo ativo e pressionando com a janela de �uxo em

seleção indo em F1 ou a depender do modo de con�guração do teclado de sua máquina use

(Fn+F1). Pronto após feito a geometria é necessário carregá-la no Database e você fará

isso utilizando o módulo Inline Geom Header Load. Abra uma nova janela de �uxo e

adicione os módulos Disk Data Input (Ddi), Inline Geom Header Load e Disk Data

Output. Como dataset de entrada no Ddi coloque o sintético que foi criado para entrada.

Em "Inline Geom Header Load"deixe default (padrão). Em "Disk Data Output"crie um novo

"dataset"de saída. Coloque este �uxo para executar. Pronto o seu dado sintético preliminar

já está pronto para entrada no módulo posterior.

Passo 2.

Inicialmente montar o �uxo de processamento com os módulos: Volume Viewer/Editor*

Velocity Viewer/Point Editor*Volume Viewer/Editor* Conforme a Figura 7 abaixo.
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Figura A.7: Figura 7: Fluxo para geração do campo de velocidades.

Vamos primeiramente criar um modelo de velocidade para um CDP apenas e em se-

guida replicar este modelo de velocidade para todos os CDPs. O módulo Volume Vi-

ewer/Editor* deve ser parametrizado da maneira explicitada na Figura 8, coloque os nú-

meros do CDP mínimo e máximo nos espaços pedidos, que vai depender da geometria do

seu modelo, e após fazer essa parametrização clique na opção de "Select input volume"na

caixa onde está escrito "INVALID"(Figura 8 lado esquerdo) e aparecerá todas as tabelas

que você tem de velocidade caso você tenha alguma, ou então nenhuma. Em seguida quando

já estiver na opção de "navigator"(navegador) equivalente a Figura 9, clique com o botão

direito do mouse e depois selecione a opção "New Promax Table", para criar a nova tabela,

após esta etapa dê um nome para sua tabela de velocidade, a opção "Type"(Tipo) deverá

está com a opção de seleção VID (Interval Velocity in Depth). Veri�que a Figura 10. Após

esta etapa clique em ok.
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Figura A.8: Figura 8: Parametrização de um dos módulos.

Figura A.9: Figura 9: Criando a tabela/campo de velocidade.

Desative os outros dois módulos por enquanto e permaneça apenas com o 1o módulo

ativado, observe que a entrada de sua tabela criada aparecerá neste módulo que por esta

ativado estará em negrito, segundo a Figura 11. Após esta etapa coloque o módulo (Volume

Viewer/Editor* ) para rodar, lembrando que os outros deverão estar desativados é claro.
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Figura A.10: Figura 10: Tipo escolhido para tabela de velocidade.

Figura A.11: Figura 11: Mostrando a ativação apenas do primeiro módulo.
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Figura A.12: Figura 12. Display do campo de velocidade (CDP x Depth).

Vai aparecer um display de CDP x Depth (m) [(Profundidade)] semelhante a Figura 12,

pode fechar esse display, em seguida no lado esquerdo do ProMAX/SeisSpace onde aparece

projetos/subprojetos/�uxos, no subprojeto que você está procure por TABLES (tabelas)

depois clique no sinal de "+"irá abrir todas as tabelas feitas e as siglas de cada uma delas

por exemplo FBP , GAT, IHD, VID e etc, na parte que tem VID clique no símbolo de

"+"aparecerá então todas as tabelas desta categoria, de acordo com a Figura 13, agora vá

no nome que você deu para sua tabela criada e clique com o botão esquerdo em cima da

tabela e depois vá na opção de "Edit using ProTab"ou apenas "Edit"a depender da versão que

você estiver usando do software. Abrirá uma janela para você poder colocar as informações,

procure um botão abaixo da opção de "HELP"ou abaixo da opção de "PREFERENCES"do

lado esquerdo, ou ainda simplesmente passe a seta do mouse em cima das opções abaixo

de "File", "Edit"e etc e procure pela opção que descreve ou é descrita como: "Insert New

Node Above Mark", para você poder inserir o número de linhas necessárias, ver Figura 14.

Ao clicar nessa opção aparecerá uma janela e nela você deverá colocar/inserir o número de

linhas que deseja para modelagem. Ao colocar este número selecione ok. Pronto após este

passo aparecerá 5 colunas preenchidas além do "Row", serão elas: X Coord, Y Coord, CDP,

DEPTH, VEL_INT. Segundo a Figura 15.
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Figura A.13: Figura 13: Tabelas de campo já feitas.

Figura A.14: Figura 14: Botão para inserção do número de linhas para a edição.



99

Figura A.15: Figura 15: Tabela preenchida mostrando todas as colunas.

Vamos iniciar o preenchimento da coluna da profundidade (depth), então primeiramente

clique em cima do nome "DEPTH ", para que toda a coluna esteja selecionada observe que

o contador das colunas (ROW) estará por consequência marcado também, veja a Figura 16.

Figura A.16: Figura 16: Passos para o preenchimento da coluna de profundidade.

Pronto então, após selecionada a tabela de "DEPTH ", vá na opção superior de "edit"clique,

depois vá em "Fill"e clique também, depois abrirá uma pequena janela denominada "Fill
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parameters", preencha com seu valor de profundidade em "Start Value". E em "incre-

mente"(incremento) coloque o valor que será incrementado ao seu valor inicial de velocidade.

Depois vá à opção de ok.

Figura A.17: Figura 17. Parâmetros de operação para manipulação da tabela.

Agora vamos editar a coluna da VEL_INT (Velocidade intervalar), da mesma maneira

que a anterior selecione ou clique em cima do parâmetro VEL_INT, depois vá em "Edit"→
"Fill "e coloque os mesmo parâmetros da "DEPTH "caso precise ou então no caso de pre-

cisar usar uma equação utilize a função de "math"lá em "edit", no meu caso eu usei uma

função que depende da profundidade então preenchi a coluna com os valores da profundi-

dade primeiramente, depois fui na opção de "Edit"→ "Math"e coloquei os parâmetros por

exemplo: se você precisa multiplicar coloque o valor que precisa ser multiplicado e depois

em "math"clique na opção de "multiply"análogo ao que pode ser visto na Figura 17. Caso

precise somar com algum valor, coloque o valor na opção de "Value"nos parâmetros do

"Math"e depois clique em "Add"e assim sucessivamente, então é só seguir este raciocínio.

Agora na coluna do CDP a selecione e depois vá a Edit "Fill e preencha tanto o "Start

Value"como o "incremente"como 0 para parametrizar para o CDP de número 0, é claro.

Depois vá em File → Resolve depois aparecerá uma janela escolha a opção "Resolve X and

Y from CDP". Geralmente este estará selecionado, depois clique em ok. Por �nal clique em

"File"novamente e "Save"para poder salvar tudo o que foi feito. Feche a janela agora.
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Figura A.18: Figura 18: Campo de Velocidade.

Após este passo por garantia rode novamente o modelo de Volume Viewer/Editor*

e agora aparecerá um display com a tabela de velocidades que você acabou de fazer ou de

editar, de acordo com a Figura 18. Pronto este modelo criado está apenas para um CDP,

vamos então agora replicá-lo, para todos os CDPs. Para isso desative o módulo Volume

Viewer/Editor* e ative o módulo Velocity Viewer/Point Editor*.

Figura A.19: Figura 19: Parametrização do móduloVelocity Viewer/Point Edi-

tor.

E parametrize este módulo da seguinte maneira conforme Figura 19. E onde se tem
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"Select input velocity database entry"clique onde está "INVALID"e selecione a tabela que

criamos para um CDP apenas (CDP "0"). Já na opção de "Select output velocity database

entry"clique em "Invalid"e crie um nome para essa saída, na área do "navigator"clique com

o botão direito e depois vá em "New Promax Table". E simplesmente dê um nome para esta

tabela de velocidade para saída. Coloque alguma coisa como Vel_all_CDPs, para que você

não se perca por exemplo. Agora é só rodar o módulo Velocity Viewer/Point Editor. E

aparecerá simplesmente o seu campo conforme Figura 20.

Figura A.20: Figura 20.Campo que será replicado para todos os CDPs.

Pode sair deste display indo em File "Save table to disk and exit. Após feito isso coloque

para rodar novamente o módulo Velocity Viewer/Point Editor* e quando este aberto vá no

canto superior a esquerda e vá na opção de Modify "Smooth Velocity Field. Pronto feito

isso abrirá uma nova janela de opção de valores, preencha essa tabela da maneira como

desejar. No meu caso em "NEW CDP SAMPLING INTERVAL"(Novo intervalo simples de

CDP) coloquei 1, para se fazer a modelagem de CDP em CDP para todos os CDPs. Em

"New Depth Sampling Interval"coloquei de 4 em 4 metros, você pode colocar o intervalo

que desejar. Nos próximos campos "CDP Smoothing Operator Length"e "Depth Smooting

Operator Length"que seriam os comprimentos dos operadores de suavização associados ao

CDP e a profundidade, coloquei no meu caso como 0 para não se ter suavização, mas pode

ser de�nido qualquer valor a escolha. Veri�que a Figura 21. Clique em Ok, e em seguida vá

na opção de "SAVE TABLE TO DISK AND EXIT", (Salvar a tabela no disco e sair).
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Figura A.21: Figura 21. Parametrização para replicar a velocidade a todos os

CDPs.

Agora desative este módulo e ative o próximo módulo novamente Volume Viewer/Editor*.

E parametrize da seguinte maneira equivalente Figura 19. E na opção de "Select input

volume"clique em "Invalid"e selecione a tabela que você acabou de criar no módulo an-

terior "alguma_coisa_all_CDPs"por exemplo. Rode este módulo agora o Volume Vi-

ewer/Editor* com a entrada de all CDPs.

Pronto você já tem esse campo para todos os CDPs com o gradiente de velocidade caso

você tenha optado pelo mesmo ou não. Veja a Figura 22. Você pode forçar o módulo a

mostrar apenas a profundidade que você deseja fazendo:



104

Figura A.22: Figura 22.Campo de velocidade editado �nal.

Quando abrir o módulo "Volume Viewer/Editor"na parte que "diz": "SOURCE OF DEPTH

COORDINATE LIMITS"clique a frente onde estará as opções de seleção "VOLUME"ou

"SEISMIC DATA"clique e selecione a opção de "USER SPECIFIED". Aparecerá então

"Minimum time /depth coordinate"e "Maximum time/depth coordinate"para ser selecionado

os valores de entrada. Coloque então o intervalo que você quer que apareça no campo de

velocidade, o valor mínimo e máximo para a profundidade. Pois no padrão os valores de

profundidade começam do negativo em diante e etc.

Agora vamos para a de�nição dos re�etores, ou melhor, diga-se de passagem, o que é

chamado aqui no módulo de horizontes. Depois de feito isso quando abrir o display de veloci-

dade, vá na opção de horizontes, como segue. Para criar um horizonte a escolha vá na opção

de "File"→ "New "→ "Horizon", abrirá uma janela para um nome ser dado ao horizonte

(re�etor) um nome pode ser de�nido a escolha. Sugestão: Coloque de preferência um nome

para este re�etor a uma profundidade de�nida. Por exemplo, re�etor 1. Profundidade 20 m

e etc.
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Figura A.23: Figura 23. Mostrando a marcação da 3o caixa ou botão de seleção a

esquerda em negrito.

Após isso vá em Ok. Depois de feito isso clique na 3o caixa/botão, na parte superior

esquerda, que está marcado em negrito. Semelhante a Figura 23 se o intervalo de de�nição

para o seu horizonte tiver difícil de ser marcado com a escala que se apresenta na tela,

então selecione o zoom para aproximar ao valor escolhido e melhor se fazer a de�nição é a

primeira caixa/botão do canto superior a esquerda de cima para baixo. Clique no botão e

depois faça a de�nição do zoom conforme desejar. Não se preocupe com nenhuma precisão

exagerada, pois essa tabela do horizonte pode ser editada em seguida, posteriormente. Para

fazer a marcação clique com o botão esquerdo nos pontos que deseja simular o início e �m

do horizonte, se quiser marque apenas o ponto inicial e �nal. Após essa marcação/de�nição

clique novamente na parte superior esquerda em "File"→ "Save"→ "Active Horizon. Para

salvar o seu horizonte ativo. Feche o display em "File "→ "Exit"para editarmos ou se editar

e/ou corrigir o horizonte na de�nição e precisão dos pontos.

Quando voltar para a tela inicial do Promax/SeisSpace na parte esquerda onde �ca os

projetos/subprojetos/Fluxos/Tabelas e etc.

Vá na opção de "Tables"clique no símbolo de "+"aparecerá todas as pastas de diferentes

tabelas procure pela pasta IDH dentro de "tables"e clique no símbolo de +, aparecerá então

a tabela que você acabou de criar, com o nome exato que você atribuiu. Evite dar espaços

nos nomes ou qualquer caractere não usual tipo ç ou e etc.. Clique no nome da tabela

com o botão direito que estará obviamente com o nome que foi dado ao horizonte quando

criado e em seguida vá em "Edit Using ProTab", pronto abrirá uma nova janela que poderá

ser editada como a criação da tabela de velocidades no primeiro módulo usado o Volume
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Viewer/Editor*. Para fazer a edição dos pontos do horizonte a ser de�nido clique no valor

da Profundidade e corrija caso não esteja exatamente no valor desejado quando marcados

manualmente, após isso veri�que os valores do CDP e altere para o valor do primeiro e do seu

último CDP, lembrando que este pode não começar do 1, vai depender de como você organi-

zou a sua geometria e etc. Após editar esses dois valores de CDP e profundidade (DEPTH ).

Clique em "File"→ "Resolve"aparecerá uma nova janela, geralmente perguntando qual o

tipo de chave para se resolver. E então escolha a chave e/ou opção de "Resolve X and Y

from CDP", geralmente esta já estará selecionada, clique então em Ok. Observe que logo

após isso a "X Coord"e/ou "Y Coord"sofrerá alteração. Agora clique no símbolo ou então

vá em "File"→ "Save"para salvar.

Seu horizonte já estará corrigido. Para visualizá-lo selecione o módulo Volume Vi-

ewer/Editor* ative-o e em seguida vá em File "Open"→ "Horizons". Aparecerá o nome

do horizonte que fora criado, clique no horizonte e depois clique em Ok. E o horizonte será

marcado no display. Para criar outro horizonte e editá-lo o passo é similar. Só um lembrete

é que depois de ir em File "New Horizon certi�que-se de que o botão 3, ou a 3o caixa abaixo

do File estará ativada para se fazer a marcação, não esqueça de salvar o horizonte também

logo após sua marcação e em seguida editá-lo para correção devida e só depois fazer um novo

horizonte, é claro, ou seja, fazer um horizonte por vez por garantia.

Após de�nir todos os seus horizontes vamos fazer a modelagem mediante com esses

limites, só lembrando que os limites do topo e da base do modelo não precisam ser de�nidos

por horizontes já serão demarcados pela célula própria respeitando os limites estabelecidos

por você.

Primeiramente abra seus horizontes para determinar o gradiente de velocidade escolhido

por você. Vá em "File"→ "Open"→ "Horizon", selecione um horizonte clique em Ok,

selecione o seguinte e clique em Ok. No seu display aparecerá seus horizontes. Pronto agora

para se determinar o gradiente de velocidade em função de seus horizontes escolhidos por

você vá em Edit "Paint Volume . Aparecerá a seguinte janela como na Figura 24.
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Figura A.24: Figura 24. Janela para inserção dos parâmetros do seu modelo �nal.

Para cada interface coloque o horizonte do topo e da base clicando em "List..."Lembrando

que as opções de "Top of Model"e "Bottom of Model"já são os próprios limites da célula

do modelo. Depois coloque o valor de velocidade em m/s no campo "Value"e caso queira

colocar um gradiente para este valor adicionado em conformidade a profundidade clique em

Depth Gradiente e coloque o valor que deverá ser acrescentado proporcionalmente a variação

profundidade. Após isso clique em Apply para aplicar. Mude o "Top Horizon"para o hori-

zonte base que usou anteriormente e coloque o novo horizonte base. Faça isso até que o seu

último horizonte seja o "Top Horizon"e então em "Bottom horizon"em List você escolherá

o "Bottom of Model". Após feito isso vá em "File"→"Save As"→"Active Volume". Dê um

nome para esse Volume e depois clique em Ok. Ao fazer isso note que mudou o padrão de

cor a depender de sua variação de velocidade de acordo com o modelo.

Veja a Figura 25. Clique agora em "Save"→ "Active Volume"e por último "File"→
"Exit".
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Figura A.25: Figura 25. Campo de velocidade após inserção dos parâmetros.

Passo 3.

Caso um horizonte seja de�nido e esta de�nição estiver com pontos de variações muito

abruptos, pode-se suavizar um ou mais horizontes. Como o campo de velocidade já foi criado

agora vamos ver como suavizar um horizonte. Para este �m abra um novo �uxo (Flow) dê

um nome para ele e em seguida procure pelo módulo "Horizon Manipulation"clique o botão

do meio no mouse para abri-lo aparecerá uma janela semelhante à Figura 26.

Figura A.26: Figura 26: Mostrando o módulo para suavização de horizontes e sua

con�guração.
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Con�gure conforme está na Figura 26. Em "Select input horizon"onde aparece como

"INVALID", clique com o botão esquerdo do mouse e então aparecerá todos os horizontes

que foram criados por você, então agora o que você tem que fazer é escolher o seu horizonte

de entrada que queira suavizar. Clique então no horizonte que deseja suavizar, com o botão

esquerdo do mouse mesmo e depois em "OK". Feito isso você precisa agora de�nir um valor

para o operador de suavização. Isso é perguntado na parte de "HALF WIDTH OF TRIAN-

GULAR SMOOTHER IN CDPs". Quanto menor esse valor escolhido mais o operador irá

suavizar e quanto maior menos ele irá suavizar. Em "FIRST CDP FOR RESAMPLING"e

"LAST CDP FOR RESAMPLING"coloque os valores de entrada para o seu primeiro e úl-

timo CDP e em "CDP INTERVAL FOR RESAMPLING"coloque o valor que você quer que

seja feito a suavização entre os CDPs no geral a depender do seu modelo é claro o mais

indicado é deixar com o valor 1 mesmo, ou seja a suavização será entre cada CDP. E em

"SELECT OUTPUT HORIZON "coloque um nome para o seu novo horizonte suavizado que

será então, criado. Para ter ideia de quanto é o poder de suavização deste módulo crie uma

saída teste e depois teste outro valor até o que �car mais apropriado de acordo com o seu mo-

delo. Para veri�car o seu horizonte suavizado, coloque o módulo Volume Viewer/Editor

para rodar como quaisquer valores do campo de velocidade criado. Em seguida quando o

campo de velocidade aparecer vá em "File"→" Open"→ "Horizon". Aparecerá à lista de

horizontes que foram criados, clique em cima do horizonte criado, depois vá em Ok. Caso

queira comparar a suavização com o horizonte original faça o mesmo processo e veja os dois

horizontes lembrando que o primeiro aberto �cará em 2o plano, mas dará para ver a sua

marcação ainda assim na hora da comparação. Como podemos ver na Figura 27.

Figura A.27: Figura 27: Visualização para comparação do horizonte original e o

mesmo suavizado.
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Para fechar os horizontes, vá novamente em "File"→"Close"→"Nome do horizonte".

Para então criar o seu novo campo de velocidade a partir desse (s) horizonte (s) é só abrir os

horizontes e então fazer como já procedemos neste tutorial anteriormente no caso dos limites

de de�nição de comportamento do modelo no passo anterior como na Figura 24.

Passo 4.

Por último depois do campo de velocidade criado agora vamos fazer �nalmente a mode-

lagem. Abra uma nova janela de �uxo e pesquise pelos módulos Disk Data Imput, Finite

Di�erence Modeling eDisk Data Output. Pronto o seu dataset de entrada no Ddi (Disk

Data Imput) será a geometria carregada do dado sintético preliminar e no móduloFinite

Di�erence Modeling a entrada será o campo de velocidade gerado e editado para todos

os CDPs e em (Disk Data Output) Ddo crie apenas um dataset de saída. Para a parame-

trização do módulo de Modelagem por Diferenças Finitas (Finite Di�erence Modeling)

onde está Velocity Field entre com o seu campo de velocidade. Na segunda opção ainda

no módulo, deve perguntar se você quer um campo de densidade então a depender do que

você queria marque como sim, para o meu trabalho não foi necessário então marquei como

não. Na terceira opção escolha "Synthetic Data", pois criamos um sintético preliminar para

a geração do sintético �nal. Da quarta opção até a 11o a parametrização é a sua escolha e

depende obviamente de seu modelo. Na opção 12 é uma condição que você escolhe para a

condição de contorno na superfície se será absorsivo ou re�exivo. Nos itens 13 marque como

"yes"pois o dado sintético �nal admitirá como entrada a geometria do sintético preliminar.

Na opção 14 você pode a depender do que queira usar a elevação do sintético preliminar

caso você tenha criado nas tabelas de geometria. Lembrando que no modelo de velocidades

a elevação/topogra�a entra no domínio como negativo, para isto basta escolher entre sim ou

não. Caso você não queira pode criar a topogra�a como horizonte no módulo de Volume

Viewer/Editor*, ao passo que já foi explicado anteriormente. Vale ainda ressaltar que

neste item caso você marque "yes"no item seguinte coloque como datum um valor maior do

que a mais alta elevação do seu dado, em conformidade a Figura 28.
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Figura A.28: Figura 28: Módulo usado na modelagem por diferenças �nitas e seus

parâmetros.

Pronto a depender do número de tiros e também de sua razão de amostragem se foi

escolhida 2 ou 4ms irá levar mais tempo para rodar o dataset de saída. Após feito isso

quando o seu Dataset de saída estiver pronto, coloque um ddi e depois um Trace Display

num mesmo �uxo ou até em outro e em seguida coloque este �uxo para rodar e pronto o

seu sismograma sintético está pronto para ser visualizado, note que a depender do número

de tiros e outras parametrizações do seu dado a saída irá demorar para ser gerada mesmo

que o poder computacional de sua máquina seja alto. Dica se quiser ver melhor o resultado
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do seu sintético quando o display aparecer, vá em "View"→"Trace Display", abrirá uma

janela, escolha as marcações Variable Density em Display Type e em "Variable Density

Controls"marque "Grayscale"em seguida clique em Ok. O display aparecerá como na Figura

29. Você pode fazer isso no próprio módulo do Trace Display na opção de "Trace Display

MODE"mudar de "WT/VA"para "Grayscale".

Figura A.29: Figura 29: Visualização do sintético na opção de Variable Density em

Grayscale em vez de Wiggle.
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